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ABOUT THIS GUIDE

Many customers have requested support for customized deployment of MindManager to large numbers of
client machines. This document provides complete information about large-scale deployments.

Topics include:

Running the standard setup manually or automatically (page 3)
Running the admin setup manually or automatically (page 3)
MindManager components (page 5)

Deploying using the installation wizard (page 19)

Deploying from the command line(page 25)

Deploying with Windows Active Directory(limited support) (page 36)
Deploying with Windows Server running Terminal Services (page 38 )
Deploying with Citrix Presentation Server (page 40)

Note: Installing MindManager on a Shared network Drive is not supported.

Note: To use MindManager with Microsoft SharePoint, you must purchase and install MindManager
Enterprise.

Throughout this document, Add-ins specific to Windows 7 32-bit include “32” at the end of the Add-in
name; those specific to Windows 7 65-bit have “64” at the end of the Add-in name.

MindManager Support Help

For technical support with this product, go to http://www.mindjet.com/support. Here you will find links to
the Knowledge Base articles, User Forums, and other online resources. You can also submit a support
request for additional assistance.

© 2015 Mindjet All Rights Reserved Version 1.0, April 15, 2015 v
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SYSTEM REQUIREMENTS FOR
MINDMANAGER INSTALLATION

REQUIREMENTS

= |BM® or
compatible
Pentium®
processor (1 GHz
or greater)

= 2GB RAM or
greater

= 830 MB disk
space

=  SVGA (1024 x
768/16-bit color or
greater)

=  Microsoft .NET 4.0
or higher

Installation Requirements

SUPPORTED OPERATING SYSTEMS

Microsoft® Windows® 8
and 8.1 32-bit and 64-bit
Microsoft® Windows® 7
32-bit and 64-bit
(includes Service Pack 1
released in Feb, 2011)

Large Scale Deployments

Citrix XenApp Version 6
Microsoft Windows
Server 2008 R2 64-bit
and later

Microsoft Windows
Server® 2003 32-bit

=  Windows Server 2008 running Terminal Services

or
= Citrix XenApp 6 64-bit

ADDITIONAL REQUIREMENTS TO USE

CERTAIN FEATURES

Microsoft Office
Professional 2003, 2007,
2010, or 2013 (32-bit and
64-bit)

Microsoft Project® 2003,
2007, 2010, or 2013(32-
bit and 64-hbit)

Microsoft SharePoint
2010 Enterprise, Standard
and Foundation servers *
Microsoft Internet
Explorer® 9.0 or greater
Mozilla® Firefox® 9.0 or
greater

Google Chrome™ 16.0 or
greater

Adobe® Acrobat® 9.2 or
greater

Adobe Flash® Player 10
or greater

Broadband Internet
Connection

* To use MindManager with
Microsoft SharePoint, you must
purchase and install MindManager
Enterprise.

If deploying MindManager in a terminal server environment, the following are prerequisites:

© 2015 Mindjet All Rights Reserved
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Using this method, each client machine must also meet the software and hardware requirements. When
running MindManager on a terminal server, the client must be able to connect and handle RDP. The
server requirements depend on the number of clients.

© 2015 Mindjet All Rights Reserved Version 1.0, April 15, 2015 2
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UNDERSTANDING DEPLOYMENT
STRATEGIES

This section provides an overview of different deployment strategies, including their basic technologies,
advantages, limitations, and their level of support.

Running the Standard Setup Manually or Automatically

You can deploy MindManager on a machine-by-machine basis using the standard setup
(MindManager . exe) by installing from the physical CD, or from a centrally accessible server. The
standard setup is robust, interactive, and user-friendly, but does not support customized deployment.

Using the standard setup has these advantages:

= MindManager installs and operates properly on supported systems
» |trequires no additional software or server resources
= Users with local administration privileges can manage the update process individually

And these disadvantages:

= Manual installation is time-consuming
» The installed software uses up disk space on each user's system
» Centralized administration becomes more difficult

Running the Admin Setup Manually or Automatically

The MindManager Admin setup provides more control over installation and administration. You can run
the admin setup from a server manually, or via a log-on script. If you use Windows Active Directory,
Group Policy, and IntelliMirror, you can install on groups of user systems.

Using the admin setup has these advantages:

MindManager installs and operates properly on supported systems

It requires no additional software or server resources

You can customize installations on a per-group or per-user basis

You can run the installation silently

The installer is not cached on the client machine, reducing the required disk space

And these disadvantages:
= Access to the original installer is required for repair and other setup operations

© 2015 Mindjet All Rights Reserved Version 1.0, April 15, 2015 3



‘ MindManager Large-Scale Deployment Guide

mindjet

Other Deployment Options

Deploying with Active Directory

This method is not yet fully supported. Due to the application architecture, MindManager only supports
Computer-based Software installations via Active Directory. User-based deployment is not supported.
Using a third party tool such as Orca allows you to edit properties for deployment. For more information,
see Deploying with Active Directory, page 36.

Deploying with Windows Server

Deploying MindManager from a terminal server to a thin client is another supported option. With this
architecture, it is possible (for example), to “run” a Windows application on a Windows client machine,
where one server services many clients. You need to deploy MindManager using Windows Server
Terminal Services to use full color mode in MindManager. For more information, see Deploying with
Windows Server, page 38.

Deploying with Citrix XenApp

The Citrix XenApp is a sophisticated terminal server environment built on top of the Windows Terminal
Services provided by Windows Server. This is currently the only tested and supported Citrix platform for
MindManager (although other combinations may work). For more information, see Deploying with Citrix
Presentation Server, page 40.

Using System Management Software and a Custom Setup

System management software, such as Microsoft System Management Server, enables you to centrally
install and administer client machines. While you can deploy MindManager using such software, there is
no specialized support for this in MindManager. This document supplies much of the information you will
need if you choose to deploy in this way.

Using system management software has these advantages:

* You can deploy the software to many machines with one command
* You can create different setups for different groups of users
» Updating the software is simple

And these disadvantages:

= You must have system management software in place
= |t takes time to create the custom setup
= The installed software uses up disk space on each user's system

Deploying on a Shared Network Drive

MindManager does not support installing on a shared network drive and having users run it directly from
there.

© 2015 Mindjet All Rights Reserved Version 1.0, April 15, 2015 4
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WHAT GETS INSTALLED

The Admin setup installs:

= Required program files

= Configurable components

= Shortcuts and Start Menu items

»  Third-party add-ins or components
» Shared system software

= Registry keys

The default location for required program files is:
C:\Program Files\Mindjet\MindManager 15

This folder contains MindManager . exe, application DLLs, and third party components. No user files are
stored in this folder.

MindManager uses merge modules to install required system software, such as ATL80.d11. If
MindManager uses a later version of a component than one already installed on the machine,
MindManager installs the required version during deployment. For more information, see Shared System
Software, below.

The first time a user runs the application, user data is placed in the default location
C:\Users\ [username] \AppData\Local\Mindjet\MindManager\15, where username is the
current user name. You must enable viewing hidden files to see this directory.

The first time a user starts the application, the application also searches to determine if a Microsoft Office
custom dictionary exists for that user.

= The first location searched is
C:\Users\ [username] \AppData\Roaming\Microsoft\UProo£f\CUSTOM.DIC (for
Unicode).

= |f the dictionary is not found there, MindManager checks for the ANSI version (which is used in
earlier Office versions) at
C:\Users\ [username] \AppData\Roaming\Microsoft\Proof\CUSTOM.DIC.

If the user-specific Microsoft Office custom dictionary is found, a reference to that dictionary is added to
the list of spelling dictionaries.

MindManager stores maps at this default location:

C:\Users\ [username] \Documents\My Maps

MindManager Components

The application installs a variety of configurable components, including:

= Library
= Dictionary

© 2015 Mindjet All Rights Reserved Version 1.0, April 15, 2015 5
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User configuration files are also installed to help govern their behavior.

Library
The Library component consists of several sub-components:

= Background Images: a library of map background wallpapers

= Icons: a library of symbols to indicate, at a glance, the status of an item

= Images: a library of pictures to help make maps more memorable

= Map Marker Lists: the library of user-created collections of map markers

= Map Parts: a library of insertable topic structures

= Shapes: a library of different topic shapes

= Styles: a library of MindManager map themes to customize the map’s overall appearance
= Templates: a library of map templates to provide a jump start on map creation

= Web: a library of web templates to format web pages

These are optional but highly recommended components.

The library is not uninstalled if you uninstall the application; this content is preserved for users upgrading
to newer versions.

The default location for the Library is:
C:\Users\[username]\AppData\Local\Mindjet\MindManager\15\Library\[language] where language is
ENU (English), FRE (French), or GER (German).

You may wish to install the library to a different location. See the documentation for deploying with the
Installation Wizard (page 19) or from the command line (page 25) for instructions.

Dictionaries

The Dictionaries component contains both spell check and autocorrect dictionaries, including dictionaries
for over 10 languages. When using the installer, you can choose which dictionaries to install. You can
also control dictionary installation from the command line.

Spell check dictionaries are removed during the uninstall process, but the autocorrect dictionaries are
preserved for users upgrading to newer versions of the application.

The default location for spell check Dictionaries is:
C:\Program Files\Mindjet\MindManager 15\sys\spell
The default location for autocorrect Dictionaries is:
C:\Users\ [username] \AppData\Local\Mindjet\MindManager\15\Spell

User Configuration Files

MindManager creates and stores user configuration files for different purposes.

Table 2: Configuration Files

FILE NAME LOCATION AND FUNCTION

ImagePropertyDatab C:\Users\ [username] \AppData\Local\Mindjet\MindManager\1
ase.dat 5

© 2015 Mindjet All Rights Reserved Version 1.0, April 15, 2015 6
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FILE NAME LOCATION AND FUNCTION

The application runtime, not the installer, creates this file dynamically. It
collects information about keywords assigned by the user to images.

UserData.ini C:\Users\ [username] \AppData\Local\Mindjet\MindManager\1
5

This file detects the first time a user launches the application and initiates
procedures such as registry cleanup.

Library.ini C:\Users\ [username] \AppData\Local\Mindjet\MindManager\1
5\Library\ [language]

This file detects the library installation time. Because the application installs
the library the first time it is launched, this file prevents multiple library
installations.

Shortcuts and Start Menu ltems

The installer puts a shortcut to the program on the Windows Desktop, the Windows Send To menu and in
the main Start menu. It creates a Mindjet MindManager 15 folderinthe Start >Programs folder
with a shortcut to MindManager in it.

The MindManager shortcut is an “advertised shortcut” to the program that automatically checks to
determine if the program needs to be repaired before it is run. If a repair is needed, it is performed then. If
you do not want to use this self-repairing feature, you can create a shortcut directly to the

MindManager . exe file instead. Deleting this copy of the installer disables the self-repair service as well.

Shared System Software

Some shared software must be installed on your system before using the admin setup. During
installation, MindManager uses merge modules to install other missing software, such as PIPanel.msm.
Missing components are installed from the modules. Depending on the host machine’s configuration, the
merge module installs the components required for that machine.

These shared components are not uninstalled automatically. Their default locations are indicated below.

© 2015 Mindjet All Rights Reserved Version 1.0, April 15, 2015 7
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Table 3: Location of Shared System Components

COMPONENT

Ink related files

C++ runtime libraries

FOLDERS AND FILES
%$CommonProgramFiles%\Microsoft Shared\Ink

= InkObj.dll

"  tpcps.dll

= PIPanel.exe*
"= PIPanel.dll¥*
= GdiPlus.dll

$WINDIR%\system32

= InkEd.dll

= PipRes.dll¥*

" wisptis.exe
* These components are installed only on Tablet PCs.
$WINDIR%\system32

"= msvcp60.dll
= msvcp80.dll

For a complete list of these merge modules’ components, see
Microsoft's documentation

Environment variable names (e.g. “CommonProgramFiles%”) are expanded to their actual values (e.g.
‘C:\Programs Files\Common Files”) by the installer.

Third-Party Software

MindManager uses specific third-party software. Unless otherwise stated, the installer checks to learn if
the component is present on the system. If not, or if the application uses a newer version, the application
installs or updates the software. The setup process places third-party software at C: \Program
Files\Mindjet\MindManager15\, and removes during the application uninstall process.

Table 4: Third-Party Software Overview

THIRD-PARTY SOFTWARE
atl70.dll

BCGCBPRO2310u.dll
BCGPStyle2010Black2310.dll
BCGPStyle2010Blue2310.dll
BCGPStyle2010White2310.dll

DESCRIPTION AND VENDOR

= Active Template Library, template-based C++ classes,
creates COM objects
= Microsoft

= BCG Control Bar Professional DLL
= BCGSoft Ltd. Portions

© 2015 Mindjet All Rights Reserved
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THIRD-PARTY SOFTWARE

Blowfish algorithm
extensibility.dll

HTS32MM.dII (for 32-hit)
hts64mm.dll (for 64-bit)

Independentsoft.Webdav.dll

libtidyu.dll
libtidy64U.dll (for 64-bit)

matrix.dll

Microsoft .NET Framework

Mfc80.dll

msvcp70.dil

redemption.dll
redemption64.dll (for 64-bit)
Sax Basic Engine
ww10_000.chm
ww10_32w.dll (for 32-bit)
ww10_64.dll (for 64-bit)
Spr32du80.dll (for 32-hbit)
Spr64du80.dll (for 64-bit)
Ssceb5532.dll (for 32-bit)
Ssceb5564.dll (for 64-bit)
Ter32mm.dll (for 32-bit)
Ter64mm.dll (for 64-bit)
Vic32.dll (for 32-bit)
Vic64.dll (for 64-bit)

MindManager Large-Scale Deployment Guide

DESCRIPTION AND VENDOR

128-bit encryption for password protection
Schneier Publishing

Allows addition of add-ins
Microsoft

An HTML control that supports inserting pictures,
hyperlinks, tables, and other objects into RTF text
Sub Systems, Inc.

WebDAV protocol client API for .NET Framework
Independentsoft

HTML Tidy fixes a variety of HTML issues
WWW Consortium

Map co-editing engine
AG Software

Microsoft Web Services Enhancements 4.0 for
Microsoft Windows Communication Foundation
Microsoft

Microsoft Foundation Classes, wrap Windows APIs in
C++ libraries, forming application framework

Other components are associated with this .dll. See
Microsoft's documentation for complete information.
Microsoft

Microsoft C++ Runtime Library
Microsoft

Supports Microsoft Outlook Integration

Components that enable VB-like scripting

Support WinWrapBasic from Polar Engineering

FarPoint Spreadsheet Control
FarPoint Technologies, Inc.

Spell checker engine
Wintertree Software, Inc.

RTF edit control
Sub Systems, Inc.

Image processor
Catenary Systems, Inc.

© 2015 Mindjet All Rights Reserved
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THIRD-PARTY SOFTWARE

vsflex8n.ocx

zlib.dll
zlib64.dll

ThirdPartyReadMe

MindManager Large-Scale Deployment Guide

DESCRIPTION AND VENDOR

= VSFlexGrid8 (Unicode) helps display, edit, and format
tabular data in spreadsheets. Helps integrate with
Microsoft Excel.

= ComponentOne

= Lossless data compression library
= Jean-Loup Gailly and Mark Adler

See the link below for additional legal information regarding Mindjet’s use of third-party software:

http://www.mindjet.com/legal/thirdpartyreadme.

The ReadMe can also be found in the installation directory:
C:\Program Files\Mindjet\MindManager 15\THIRDPARTYREADME. txt

Registry Keys

The installer places any per-machine Mindjet registry settings in or below the key:

HKEY LOCAL MACHINE \SOFTWARE\Mindjet\MindManager\15

These are the settings used by the application and its add-ins on a per-machine basis. No per-user

values are stored in this key.

Following Windows guidelines, the application registers its associated file types, COM objects, etc., in

sub-keys of HKEY CLASSES_ROOT.

Table 5: Registry Key Overview

KEY TYPE

LocATION/KEY

HKEY_LOCAL_MACHINE HKEY_ LOCAL MACHINE\SOFTWARE\Mindjet\MindManager\15

HKEY_CLASSES_ROOT HKEY CLASSES_ROOT\...(all keys below this level)

.mmap
.mmas

.mmat

.mmbas

.mmmp

.mmms

.mmp
Mindjet.MindManager.Custom.Document
Mindjet.MindManager.Document.x
Mindjet.MindManager.Document.Template.x
Mindjet.MindManager.Macro.x
Mindjet.MindManager.MapMarker.x

© 2015 Mindjet All Rights Reserved
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KEY TYPE LocATION/KEY

Mindjet.MindManager.MapMarkerSet.x
Mindjet.MindManager.MapPart.x
Mindjet.MindManager.Style.x
Mindjet. Mm5GenericSmartMapPart.AddIn
Mindjet. Mm5GenericSmartMapPart. AddIn.x
Mindjet. Mm5Sort.AddIn

Mindjet. Mm5Sort.AddIn.x

Mindjet. Mm5WebExportAddin
Mindjet. Mm5WebExportAddin.x
Mindjet. Mm10ExcelLinker.AddIn.x
Mindjet. Mm10ExcelLinker.AddIn
Mindjet. Mm10MsProject.AddIn
Mindjet.Mm10MsProject.AddIn.x
Mindjet.Mm100utlook.AddIn
Mindjet.Mm100utlook.AddIn.x
Mindjet.Mm100utlookLinker.AddIn
Mindjet. Mm2100utlooklinker.AddIn.x
Mindjet. Mm10PPExport.AddIn
Mindjet. Mm10PPExport.AddIn.x
Mindjet.Mm210Project.AddIn
Mindjet. Mm10Project.AddIn.x
Mindjet.Mm10Word.AddIn
Mindjet. Mm10Word.AddIn.x
MindManager.Application
MindManager.Application.x
MindManager.Color
MindManager.Color.x
MindManager.TextFont
MindManager.TextFont.x
Mm5WebExport.Page
Mm5WebExport.Page.x
Mm5WebExport.Pages
MmbWebExport.Pages.x
Mm5WebExport.VariantSets
Mm5WebExport.VariantSets.x
Mm5WebExport.WebExport
Mm5WebExport.WebExport.x
Mm5WebExport.WebExports
Mm5WebExport.WebExports.x
MM8InternetExplorer.BHO
MM8InternetExplorer.BHO.x

Uninstall Key HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\Curre
ntVersion\Uninstall

HKEY_CURRENT_USER HKEY CURRENT USER\Software\Mindjet\MindManager\15

Uninstall information for the program is stored in a sub-key of:
HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall

© 2015 Mindjet All Rights Reserved Version 1.0, April 15, 2015 11



‘ MindManager Large-Scale Deployment Guide

mindjet

The name of the sub-key is the Globally Unique Identifier (GUID) for the program (which changes with
each release). You can find it by using RegEdit to search for “MindManager” in the Uninstall key. The
uninstallation key does not remain after uninstalling.

When a user runs the application, any per-user registry settings are stored in or below the key:
HKEY CURRENT USER\Software\Mindjet\MindManager\15

Some Current User keys remain after uninstalling. These keys help preserve user data for upgrading to
the next version of MindManager.

© 2015 Mindjet All Rights Reserved Version 1.0, April 15, 2015 12
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WHAT REMAINS AFTER
UNINSTALLATION

When you uninstall, almost all traces of the application are removed, including all components located at
C:\Program Files\Mindjet\MindManager 15. Most registry keys are removed as well. Map files
(.mmap files) are not deleted.

On Microsoft Windows 7 or any other system where the system administrator has disallowed the use of
RegEdit to export the registry key (i.e. DisableRegistryTools is set), the registry key is backed up to a
MindManager registry subkey under:

HKCU\Software\Mindjet\MindManager\MMX15RegistryBackup <date> <time>.
Otherwise the keys are stored under
C:\My Documents\MMX15RegistryBackup <date> <time>

Some the remnants of the application are left behind. These are needed to preserve user data when
upgrading to a newer version. See Remaining Files, Folders, and Software Components (page 14) and
Remaining Registry keys (page 14) for more information.

Remaining Files, Folders, and Software Components

When you uninstall, the installer leaves behind some components it installed with the program. The tables
below reflect the most common remaining components and registry keys. The actual list may vary
depending upon the installation and deployment. In general, components left behind fit one of these
scenarios:

= User data (the library, images, and templates) remains to support upgrading to the next version or
= Shared components, such as C++ libraries, and their registry keys get left behind because they
may be required for other purposes

or

= A backup of your registry

Table 6: Remaining Files, Folders, and Software components

COMPONENT LOCATION AND EXPLANATION

C++ runtime libraries See Shared System Software (page7) for locations.
These files may be in use by other applications.

Ink related files See Shared System Software (page7) for locations.

These files may be in use by other applications.
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COMPONENT

MMX15RegistryBackup_<d
ate>_<time>

msvcp60.dil
msvecrt.dll

XML-related files

User Data

MindManager Large-Scale Deployment Guide

LOCATION AND EXPLANATION
C:\MyDocuments\

Opening this file gives you the option to add its contents to your
current registry.

$WINDIR%\system32

This software may be in use by other applications.
$WINDIR%\system32

This software may be in use by other applications.
See Shared System Software (page7) for locations.

These files may be in use by other applications.

C:\Users\ [username] \AppData\Local\Mindjet\MindMana
ger\15

Contains dictionaries, images, templates dictionaries etc. that the
user may have customized. Does not uninstall so the user does not
lose this data when upgrading.

Remaining Registry Keys

Table 7: Remaining Registry Keys

REGISTRY KEY
HKEY_CLASSES_ROOT

HKEY_CURRENT_USER

LOCATION AND EXPLANATION
HKEY_CLASSES_ROOT\

= .mmap
= .mmp

These keys register .mmap file extensions.
HKEY CURRENT USER\Software\Mindjet\MindManager\15\

Keys at or below this preserve user data for upgrading.

© 2015 Mindjet All Rights Reserved
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USING THE ADMIN SETUP

The Admin setup gives systems administrators more control over an installation. It is distributed in a .zip
archive that contains the following files:

= Mindjet MindManager 15 Admin.msi

The MindManager Microsoft installer.

* dotNetFx40_Full setup.exe

Microsoft’'s .NET Framework redistributable setup.

= instmsi30.exe

Microsoft Windows Installer engine setup. (Normally this is already on the target system.)

* msxml6_ x86.msi(for 32-bit) or msxml6_ x64.msi (for 64-bit)
The MSXML 6.0 installer.

* vcredist 2010_spl x86.exe
* vcredist 2010_spl x64.exe

Microsoft Visual C++ run-time environments for version 2010 (including 2010 for 64-bit
machines.)

» MindManager_Large_Scale_Deployment_Guide.pdf
This Deployment Guide.

Using the admin setup gives you nearly complete control over your deployment, including:

= Deploying (or not deploying) specific components
= Disabling functions, such as internet access
= Storing components on network drives, such as user data or the library

You also have the option of configuring many items from the registry.
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Required Software

All required software is in included in the Admin setup package. It contains some software that must be
installed on your system before using the setup. You should verify that this software is already installed
on your system; if not, install it from the admin package.

* vcredist 2010_spl_x86.exe installs the VC++ Redistributable components for Visual Studio
2010.

Check for existence of registry key:

HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\
{FOC3E5D1-1ADE-321E-8167-68EFODE699A5}

Or simply re-install.

* vcredist 2010_spl_ x64.exe installs the VC++ Redistributable 64-bitcomponents for Visual
Studio 2010. (Only for 64bit machines.)

Check for existence of registry key:

HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\
{1D8E6291-B0OD5-35EC-8441-6616F567A0F7}

Or simply re-install.
* msxml6 x86.msi Ormsxmlé_x64.msi installs the MSXML 6.0 SP1 Parser
Check the installed programs in the Control Panel to check existing installation.
* dotNetFx40_ Full setup.exe installs the Microsoft Net Framework

Check the installed programs in the Control Panel to check existing installation. This install can
take quite a long time.

Note: You should check for and install any missing components in the order listed above.

Required Permissions and Privileges

Administrator privileges are required to install any Windows software, including MindManager.

No special privileges or disk permissions are required to run the application. A user can run the program
as a restricted user, a “normal” user, a power user, or an administrator. The program does assume that
the user has read/write/create privileges in the HKEY_CURRENT_USER registry key as well as in the
user profile section of the hard disk and below.

Differences between the Standard and Admin Setups

The Admin setup is based on the standard setup—with a number of important differences:

Caching: The admin setup does not cache the setup on the computer where it is being installed.
Instead, the setup should be run from a network location that remains accessible from the workstation
at all times. This ensures proper operation of the Modify, Repair, and Remove entries in the
“Add/Remove programs” Control Panel applet, and avoids duplication of the installation source on
every system where the application is installed.
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Patching: Admin setups are only delivered as full setups, not patch setups. The reason for this is that
system administrators might modify the admin setup to suit the needs of their individual company. If
the installation database is transformed in this way, a future patch would not be able to properly
update the installation. We avoid this problem by not delivering patch updates at all for our admin
setups. To upgrade, you need to uninstall the previous version and install the upgrade.

Packaging: We exclude the Microsoft Windows Installer engine and .NET Framework installer. Both
components must be installed prior to running MindManager.msi if they are missing from a user’s
machine.

User Data: The admin setup includes the option to specify the location of user data.

Library Files: There is also an option to have the application extract the library files as usual, or to
have the administrator set this up “manually,” ahead of time. For more information, see Deploying
User Data and the Library to a Server, page 22.

Installing MindManager: An Overview

This section gives an overview of the admin setup and application components. With this information, you
can understand the installation process and determine what you may wish to customize for your
deployment.

Per-machine Setup

The setup installs the program on a client machine and only sets per-machine registry settings in the
HKEY LOCAL MACHINE and HKEY CLASSES_ ROOT registry keys. It does not directly create or set any
registry keys or values in the HKEY CURRENT USER registry key.

The installer installs all program files to this default folder:
C:\Program Files\Mindjet\MindManager 15

Administrator privileges are required to install any Windows software, including MindManager.

Per-user Setup

Each time the application launches, it checks the UserData.ini file, located in
C:\Users\ [username] \AppData\Local\Mindjet\MindManager\15 to determine if a per-user
setup needs to be performed.

If this file is missing, or if the version of the application installed is newer than the version the user last
ran, then MindManager prepares for a “new” per-user installation by deleting the following registry key:

HKEY CURRENT USER\Software\Mindjet\MindManager\15\User Interface

The application also determines if the per-user application data files (outline print templates and spell
check auto-correct dictionaries) are present. If not, it copies them from the “All Users” folder:

C:\Users\ [username] \AppData\Local\Mindjet\MindManager\15

Finally, the application determines if the per-user Library files need to be installed using the same
UserData.ini algorithm described above and checks the LSDLibraryExtract. If the registry is not set to
0, then a separate background task/program is run to unzip the library files from a MindManager sub-
folder:
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C:\Program Files\Mindjet\MindManagerl5\sys\[language]

The Vista system folder structure uses environmental variables instead of real paths. Note the different
path structure below:

$USERPROFILE%\Local Setting\Application Data\Mindjet\MindManager\15
$ALLUSERPROFILE%\Application Data\Mindjet\MindManager\15
$ProgramFiles%\Mindjet\MindManagerl5\sys\ [language]

© 2015 Mindjet All Rights Reserved Version 1.0, April 15, 2015 18
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DEPLOYING WITH THE
INSTALLATION WIZARD

Using the admin setup to install the application is straightforward and simple. Unlike the basic setup, you
have customization options, though not as many as from the command line.

Starting the Installation

To install the application:

1. Launch the installer.

2. Atthe welcome screen, click Next.

3. Select “| agree to the terms of the license agreement” and click Next.
4. Enter the Customer Information (User Name and Organization).
5

Click Next.

The Setup Type dialog appears.

f%"-lﬂindjet MindManager Setup Ef

Setup T
s MindManager‘N

Please select a setup type.

@ Standard

All program features will be installed.
w Recommended for most users.

will be installed.

Choose which program features you want installed and where they I

InstaliShield

[ < Back J[ Next > ] [ Cancel J
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At this point, you can customize your deployment or complete the installation (page 23).

Customizing the Installation

A custom installation allows you to:

= Disable default features
= Change the default installation folder
= Deploy user data and the library on a separate server

If you need to customize the installation beyond these parameters, see Deploying from the Command
Line (page 25).

Disabling Default Features

To disable the default installation features:
6. Complete steps 1-5 in Starting the Installation (page 19).
7. Select Custom and click Next.
The Custom Setup dialog appears.

8. Inthe tree, select a feature whose default installation you want to change.

9. Click the down arrow button l:

10. Select the desired feature setting.

Custom Setup
MindManager |

Click on an icon in the list below to change how a feature is installed.

= o Feature Description

HE’—I MnndManéger ) The RSS Feeds allows you to display l
: Microsoft Add-ins RSS feeds in MindManager.
£ Dictionaries
B RSS Feeds

=3 Thisfeature will be installed on local hard drive.

=38 This feature, and all subfeatures, will be installed on local hard drive.

X  This feature will not be available.

M
Install to:
C:\Program Files\Mindjet\WMindManager 15\
InstaliShield -
[ hHlp || space || <Back |[ Next> [ cancel |

;gm
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For each selected feature, a description and storage requirement appears.
11. Repeat this process until you have made all of your feature customization choices.

12. Complete the installation as outlined in Completing the Installation (page 23).

Changing the Default Installation Folder
To change the default installation folder:
13. Complete steps 1-5 in Starting the Installation (page 19).

14. Select Custom and click Next.

The Custom Setup dialog appears.

MindManager

Click on an icon in the list below to change how a feature is installed.

=T v Feature Description
E]Q—I MlndManéger ] The RSS Feeds allows you to display I
(- &3 v | Microsoft Add-ins RSS feeds in MindManager.

@ ) ~ | Dictionaries

This feature requires 61KB on your

hard drive.
Install to:
C:\Program Files\Mindjet\MindManager 15\
InstallShield
T —, | r— | e | e | -
- ——a!

15. Click Change.

The Change Current Destination Folder dialog appears.

16. Select the destination folder.

17. Click OK.

The new destination folder appears in the Custom Setup dialog.

18. Complete the installation as outlined in Completing the Installation (page 23).
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Deploying User Data and the Library to a Server
MindManager installs a “Library” folder containing:

= Background Images

= |cons

* Images

= Map Parts
= Shapes

= Styles

=  Templates
=  Web Export Templates

The entire library consists of several megabytes. By default, these files are stored on a per-user basis in

this folder:
C:\Users\ [username] \AppData\Local\Mindjet\MindManager\15\Library\ [language]

where language is ENU (English), FRE (French), or GER (German).
You can store user data and the library in a network folder for if you wish to:

» Save space on users' systems

= Decrease the time required to run the program the first time

= Allow roaming user’s access to their customized libraries

= Assure that all users have a fixed, easily updatable set of library files

You can install these files once to a common location (perhaps in a read-only folder). Multiple users can
then share the files, or a single user can access them from multiple machines. If a user needs to edit
these files, install them in a directory with write privileges.

You cannot install user data and the library to separate locations from the installation wizard. To install
them separately, you must install them from the command line (page 25).

To deploy user data and the library to a server:
19. Complete steps 1-5 in Starting the Installation (page 19).
20. From the Custom Setup dialog, click Advanced.
The Deploy User Data Files dialog appears.

21. Select Deploy user data on server.
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|

' 1) Mindjet MindManager Setup

Deploy user data files

MindManager

(") Install user data files on local disk

I This is the recommended method for standard installations. User data files are installed into
the standard Windows per-user data location.
@ Deploy user data on server

Use this method to store all user data files in a central server folder. Please make sure you

have read the large scale deployment installation document you can download from the
Mindjet website.

Server base path:

l Browse...

[T]Extract library to the server path the first time MindManager starts

[]use separate folders per user

InstaliShield

( oK ][ cancel |

22. Click Browse.

The Browse for Folder dialog appears.

23. Select the destination folder.

24. Click OK.

The new directory appears in the Server base path field.
25. Choose from the following options:

= Extract library to the server path the first time the application starts
= Use separate folders per user

We recommend selecting both of these options to avoid needing to configure the user data folder and the
library folder separately. You may want to create the user folders before installation, giving you the
chance to make the files read only.

26. Click OK to close the dialog.
27. Complete the installation as outlined in Completing the Installation (page 23).

These are all of the customization choices available from the installer interface. You have more control if
you deploy from the command line (page 25).

Completing the Installation

To complete the standard installation:
28. Select Complete and click Next.
The Ready to Install dialog appears.
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29. Choose your shortcut options.
30. Click Install.
31. After the installation is complete, choose from the following options:

* Launch MindManager
= Register MindManager

32. Click Finish.
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DEPLOYING FROM THE COMMAND

LINE

While you may wish to customize your deployment from the installer interface (page 20), you have much
greater control over the installation from the command line, including:

Configuring installation parameters (page 25)

Specifying what to install on a feature by feature basis (page 26)
Enabling or disabling program functions

Specifying where to install libraries, and user data (page 32)
Using a custom SharePoint SiteConnections.xml file (page 55)*

*To use MindManager with Microsoft SharePoint, you must purchase and install MindManager Enterprise.

This section identifies what you may configure and provides examples of command line arguments for
customizing your deployment. A sample installation command demonstrating most of these options is
included in Sample Setup Commands (page 35).

Configuring Installation Parameters from the Command Line

You can set a number of public properties with command line options.

Table 8: Configuring Installation Parameters from the Command Line

PARAMETER
INSTALLDIR

ISX_SERIALNUM

USERNAME

COMPANYNAME

DESCRIPTION OF VALUES

Specifies where the application should install the program. For
example:

"C:\Program Files\Mindjet\MindManager 15\"

Specifies the license key for your installation. Note: No validation is
performed for this key, it is simply written to the registry. If the license
key is not valid, the application runs in a restricted (trial) mode.

Specifies the User Name for registering the application.

Optional parameter; the Windows User Name will be used if this
parameter is not supplied.

Specifies the Company Name for registering the application.

Optional parameter; the Windows Company Name will be used if this
parameter is not supplied.

© 2015 Mindjet All Rights Reserved
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Configuring Features from the Command Line
The admin setup is a Basic MSI project, not an InstallScript project; there is no record mode to run an
install with Setup.iss. Basic MSI projects do not create or use a response file for silent installations.

Tip: When configuring features from the command line, it is better to use /s silent installation to avoid
conflicts with properties set through the installer interface. You can remove or add features from the
command line by using ADDLOCAL or REMOVE on a feature by feature basis. To simplify the process, use
ADDLOCAL="ALL" and then remove features you do not want. Examples are provided below.

Customizing the Installation with Setup.exe
You can use the following options to add or remove features from the command line setup.exe:
/v=command line access to msi file

/gn=when used with /v parameter, silent (no user interface) parameter
passed to msi file

Here are examples of adding and removing features through the setup.exe file, using silent install:
Adding:
<directory>\setup.exe /v"ADDLOCAL=\"MSWordAddin\" /qgn"
Removing:
<directory>\setup.exe /v"ADDLOCAL=\"ALL\" "REMOVE=\"MSWordAddin\" /gn"
You can also string together multiple features for inclusion or removal:
<directory>\setup.exe

/v"ADDLOCAL=\"Al11l\" REMOVE=\"MSWordAddin,RSS\" /qn"

Customizing the Installation with MSI
You can use these options to add or remove features from the command line with MSl.exe:
/i=install mode

/gqn=silent (no user interface) parameter (Tip: /qn+ will let you know
when it’s done)

Note: On Windows 7 and above, security features require that you run silent install (/qn) as the
Administrator, not as a member of the Administrator group.

Here are examples of adding and removing features through the msiexec.exe file, using silent install:
Adding:
msiexec /i "<directory>\filename.msi" ADDLOCAL="MSWordAddin" /qn

Removing:
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msiexec /i "<directory>\filename.msi" ADDLOCAL="ALL"
REMOVE="MSWordAddin" /qgn

You can also string together multiple features for inclusion or removal:

msiexec /i "<directory>\filename.msi" ADDLOCAL="ALL"
REMOVE="MSWordAddin, PDFWriter ,RSS" /qgqn

Table 9: Configuring Features with MSI from the Command Line

FEATURE COMMENTS
Library Available add-ins

The default add-in is Library, which installs add-ins below. You can
also specify a subset.

* Images

= Shapes

= Backgroundimages
= |cons

= ImageGallery

= TemplateOrganizer
=  Templates

=  WebTemplates

= Styles

= MapParts

= Markers
Example:

msiexec /i "<directory>\filename.msi" ADDLOCAL="ALL"
REMOVE="WebTemplates" /qn

Dictionaries Available add-ins

The default add-in is Dictionaries, which installs add-ins below. You
can also specify a subset.

= Swedish

= Spanish

= Norwegian

= BrazilianPortuguese

= [talian

= Danish

»= Finnish

= CanadianEnglish

= USEnglish

= UKEnglish

= French

= Dutch

= German
Example:

msiexec /i "<directory>\filename.msi" ADDLOCAL="ALL"
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COMMENTS
REMOVE="CanadianEnglish" /qn

Available add-ins:

The MSAddins feature is a container for the following Microsoft-related
add-ins. Any or all of these sub-features can be all installed by
specifying them on the command line. (Examples below clarify this.)

MSWordAddin (for 32-bit) or MSWordAddin64 (for 64-bit)

MSOutlookLinkerAddin (for 32-bit) or MSOutlookLinkerAddin64 (for 64-
bit)

MSOutlookMapMinderLinkerAddin (for 32-bit) or
MSOutlookMapMinderLinkerAddin64 (for 64-bit)

MSPowerPointAddin (for 32-bit) or MSPowerPointAddin64 (for 64-bit)
MSProjectAddin (for 32-bit) or MSProjectAddin64 (for 64-bit)
MSExcelLinkerAddin (for 32-bit) or MSExcelLinkerAddin64 (for 64-bit)
MSIEAddin (for 32-bit) or MSIEAddin64 (for 64-bit)

Note:

This MSAddins feature, and all sub-features, can be removed with
REMOVE="MSAddins” but they cannot be added with
ADDLOCAL=“"MSAddins."”

Example:

There are three options for including a feature that's not installed:
1. Include the selected feature
2. Include the selected feature and all sub-features

3. Include the selected feature and then select sub-features
individually

= Using ADDLOCAL="MSAddins" is equivalent to (1) above.
However, this causes no add-ins to be added since
MSAddins is just a container for other add-ins, and they
need to be specified.

= ADDLOCAL="MSAddins, MSExcellinkerAddin,
MSIEAddin, MSOutlookLinkerAddin,
MSPowerPointAddin, MSProjectAddin,
MSWordAddin" or (for 64-bit version)
ADDLOCAL="MSAddins, MSExcellLinkerAddiné64,
MSIEAddin64, MSOutlookLinkerAddiné64,
MSPowerPointAddin64, MSProjectAddiné4,
MSWordAddiné4" is equivalent to (2) above.

= Using a subset of MSTEAddin, MSIEAddin64;
MSOutlookLinkerAddin,
MSOutlookLinkerAddin64; MSPowerPointAddin,
MSPowerPointAddin64; MSProjectAddin,
MSProjectAddin; MSWordAddin, MSWordAddiné64
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COMMENTS
is equivalent to (3) above.
The add-in is RSS

Example:

msiexec /i "<directory>\filename.msi" ADDLOCAL="ALL"
REMOVE="RSS" /qn

Configuring Functions from the Command Line

During installation, you can disable some functions by setting the value to “0.” For example:

msiexec /i "<directory>\Mindjet Admin.msi" /qn ONLINEHELP="0"

Table 10: Configuring Functions from the Command Line

FUNCTIONS
Macro Support

Shortcuts

Internet Access

Online Help

EXAMPLES
The function name is MACROUI.
Example (msi):

msiexec /i "<directory>\MindjetAdmin.msi" /qn
MACROUI="0"

The function names are:

* SHORTCUTDESKTOP
*= SHORTCUTSTARTMENU
= SHORTCUTQUICKLAUNCH

Example:

msiexec /i "<directory>\Mindjet Admin.msi" /gn
SHORTCUTSTARTMENU="0"

The function name is INTERNETACCESS.
Example(msi):

msiexec /i "<directory>\Mindjet Admin.msi" /gn
INTERNETACCESS="0"

Example (setup.exe):

<directory>\setup.exe /s /v"INTERNETACCESS=0 /gqn"
The function name is ONLINEHELP.

Example (msi):

msiexec /i "<directory>\Mindjet Admin.msi" /qgn
ONLINEHELP="0"
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EXAMPLES
Example (setup.exe):
<directory>\setup.exe /s /v"ONLINEHELP=0 /qn"
The function name is UICUSTOMIZATION.
Example (msi):

msiexec /i "<directory>\Mindjet Admin.msi" /qgn
UICUSTOMIZATION="1"

Example (setup.exe):

<directory>\setup.exe /s /v"UICUSTOMIZATION=1 /gn"
The function name is DISABLEATTACHMENTS

Example (msi):

msiexec.exe /i "Mindjet Admin.msi"
DISABLEATTACHMENTS=1 /qn
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Configuring Functions from the Registry

The application supports configuring specific functionality in the registry before installing the application.
The installer reads these keys and retains these settings. After installation is complete, you can hand-
configure these settings as well. To disable a function, set the registry value to “0.” Reset the value to “1”
to re-enable the function. Each key is of the type REG_DWORD except the License key.

Table 11: Configuring Functions from the Registry

FUNCTIONS
Macro Support

Internet Access

Online Help

Ul Customization

Connect Access

Disable Attachments

Effort

EXAMPLES
The registry key is MacroUiEnabled.
Example:

HKEY LOCAL MACHINE\Software\Mindjet\MindManager\15\s
ettings "MacroUiEnabled" (0)

The registry key is InternetConnectionEnabled.
Example:

HKEY LOCAL MACHINE\Software\Mindjet\MindManager\15\S
ettings "InternetConnectionEnabled" (0)

The registry key is OnlineHelpEnabled.

Example:

HKEY LOCAL MACHINE\Software\Mindjet\MindManager\15\S
ettings "OnlineHelpEnabled" (1)

The registry key is EnableUserCustomization.

Example:

HKEY LOCAL MACHINE\Software\Mindjet\MindManager\15\s
ettings "EnableUserCustomization" (1)

The registry key is Connect3Enabled.

Example:

HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\lS\S
ettings "Connect3Enabled" (1)

Note: Connect is turned on by default in version 10.0, and this key
must be entered manually.

The registry key is DisableAttachments.
Example:

HKEY_LOCAL_MACHINE\Software\Mindjet\MindManager\lS\S
ettings "DisableAttachments" (1)

The registry key is ShowEffort.
Example:
HKEY LOCAL MACHINE\SOFTWARE\Mindjet\MindManager\15\S
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EXAMPLES
ettings\ShowEffort

Note: Set dword to either 0 or 1 during an LSD (or setup.exe)
installation.

The registry key is License Key.
Example:

HKEY LOCAL MACHINE\SOFTWARE\Mindjet\MindManager\15\R
egistration

Note: Use .reg script to set the key via ISX_SERIALNUM deployment.

The registry key is Connect3ApiEnabled
Example:

HKEY CURRENT USER\Software\Mindjet\MindManager\15\Se
ttings\Connect3ApiEnabled

HKEY LOCAL MACHINE \SOFTWARE \Wow6432Node\Mindjet\Mind
Manager\15\Settings\Connect3ApiEnabled

Note: Adds ‘Let add-ins use online features’ checkbox to Add-Ins
tab of Options dialog.

Deploying User Data and the Library

As discussed previously in Deploying User Data and the Library to a Server (page 22), you may want to
deploy user data and the library to a server. If you want to deploy the user data and library on separate
servers, you must do so from the command line or by editing the registry.

Deploying User Data and the Library from the Command Line

The following commands give you the ability to deploy user data and the Library to separate locations.
Each option consists of a property, which (when given a command line value) writes to the registry. You
can also predefine these options by creating and executing a registry script before a silent setup.
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Table 12: User Data Deployment Options

COMMAND

USERDATAPATH="<user
specified path>"

USERDATAPERUSERPAT
H="1"

USERDATAPATHSUFFIX="
<user specified path>"

Example:

RESULTING REGISTRY ENTRY

HKEY LOCAL MACHINE\Software\Mindjet\MindManager\15
\Installer "LSDUserDataPath" "<user specified
path>"

Deploy user data in a per-user folder.
1=Enable
O=Default or disable

HKEY LOCAL MACHINE\Software\Mindjet\MindManager\15
\Installer "LSDUserDataPerUser" (1)

This folder is appended to the per-user folder.

HKEY LOCAL MACHINE\Software\Mindjet\MindManager\15
\Installer "LSDUserDataPathSuffix" '"<user
specified directory>"

msiexec /i "Mindjet Admin.msi" USERDATAPATH="C:\Temp\UserData"
USERDATAPERUSERPATH="1" USERDATAPATHSUFFIX="MyUserData"

Table 13: Library Deployment Options

COMMAND

LIBRARIESPATH="<user
specified path>"

LIBRARIESPERUSERPATH
="1"

LIBRARIESPATHSUFFIX="
<user specified directory>"

LIBRARIESEXTRACT="1"

RESULTING REGISTRY ENTRY

HKEY LOCAL MACHINE\Software\Mindjet\MindManager\15
\Installer "LSDLibraryPath" "<user specified
path>"

Deploy libraries in a per-user folder.
1=Enable
O=Disable

HKEY LOCAL MACHINE\Software\Mindjet\MindManager\15
\Installer "LSDLibraryPerUser" (1)

This folder is appended to the per-user folder.

HKEY LOCAL MACHINE\Software\Mindjet\MindManager\15
\Installer "LSDLibraryPathSuffix" "<user specified
directory>"

Extract libraries to path the first time the application starts.
1=Enable
O=Disable

HKEY LOCAL MACHINE\Software\Mindjet\MindManager\15
\Installer "LSDLibraryExtract" (1)
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Example:

msiexec /i "Mindjet Admin.msi" LIBRARIESPATH ="C:\Temp\Libraries"
LIBRARIESPERUSERPATH ="1" LIBRARIESPATHSUFFIX ="MyLibraries"
LIBRARIESEXTRACT="1"

Deploying User Data from the Registry

During a silent (non-interactive) installation, you can deploy data user files by setting some registry values
on the user's system in the registry key before running the installer:

HKEY LOCAL MACHINE\Software\Mindjet\MindManager\15\Installer

Table 14: User Data Registry Key Values

REGISTRY VALUE DATA VALUE
LSDUserDataPath Examples:
N:\User Data\All Users\Mindjet\MindManager\
or
N:\User Data (if LSDUserDataPerUser is set to 1)
LSDUserDataPerUser 0 = Do not use separate folders per user
1 = Do use separate folders per user
LSDUserDataPathSuffix See above
Example:
Mindjet\MindManager\15
Only applies if LSDUserDataPerUser is set to 1

If you want to deploy all of the user data (including the library) on a server, create a registry file named
“‘MindManager Large-Scale Deployment Options.reg” like this:

REGEDIT4

[HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet]
[HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager]

[HKEY_LOCAL MACHINE\SOFTWARE\Mindjet\MindManager\15]

[HKEY LOCAL MACHINE\SOFTWARE\Mindjet\MindManager\15\Installer]
"LSDUserDataPath"="N:\\User Data\\All Users\\Mindjet\\MindManager 15"
"LSDUserDataPerUser'"=dword:00000001

"LSDUserDataPathSuffix"="User Data"

“LSDLibraryPath= N:\\All Users\\Mindjet\\MindManager 15”
"LSDLibraryPerUser"=dword: 00000001
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"LSDLibraryPathSuffix"="Library"
"LSDLibraryExtract"=dword:0000001

Sample Setup Commands

The following sections provide sample commands to demonstrate various installation scenarios.

Simple Installation
This command simply runs the installer in the usual interactive mode.
Msiexec.exe /i "Mindjet Admin.msi"

You can also run MindManagerAdmin.msi from Windows Explorer.

Silent Installation

This command silently runs the installer, supplying values for all required parameters.

Msiexec.exe /i "MindManagerAdmin.msi" /qn INSTALLDIR="C:\Program
Files\Mindjet\MindManager 15\" ISX SERIALNUM="MPxM-MMIl-XXXX-XXXX-XXXX"

Note that the "xxxx-xxx-xxxx-xxxx-xxxx" portion of the license key must be replaced with a valid
key. Optional parameters are USERNAME and COMPANYNAME.

Sample Customized Installation Using ADDLOCAL and REMOVE

Here is an example for a customized silent install, using ADDLOCAL and REMOVE:

Msiexec.exe /i "Mindjet Admin.msi" /gqn /L*v "C:\MM15AdminSetup.log"
INSTALLDIR="D: \Program Files\Mindjet\MindManager 15\"
ISX_SERIALNUM="MPxM—MM1—xxxx—xxxx—xxxx" USERNAME="John Doe"
COMPANYNAME="Acme, Inc." ADDLOCAL="ALL" REMOVE="MMPlayerExport,
MSWordAddin" MACROUI="0" INTERNETACCESS="0" UICUSTOMIZATION="O"
ONLINEHELP="0"

Silent install options for the MMPlayerExport key that supports the Viewer feature are available and
supported using Admin .MSI package.

To remove the feature:

msiexec /i PATH_TO.msi ADDLOCAL="ALL" REMOVE="MMPlayerExport" /qgn\
To re-instate the feature:

msiexec /i PATH_TO.msi ADDLOCAL="MMPlayerExport" /qn

Uninstallation

This command uninstalls the application:

Msiexec.exe /x "MindManagerAdmin.msi"
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DEPLOYING WITH ACTIVE
DIRECTORY

Deploying via Active Directory and Group policies is has limited supported at this time because:

= The setup only supports computer-based software installation
= Some properties can only be configured from the command line

You can use configuration tools such as Orca to:

= Configure properties from the property table
= Save the settings to a transform file (MST)

= Deploy it with the updated values

PROPERTY
INTERNETACCESS=1/0

ISX_SERIALNUM

LIBRARIESPATH=<defaultpath>

LIBRARIESPATHSUFFIX=<defaultpath>
LIBRARIESPERUSERPATH=0/1

LIBRARIESEXTRACT=1/0

USERDATAPATH=<defaultpath>
USERDATAPATHSUFFIX=<defaultpath>
USERDATAPERUSERPATH=0/1

MACROUI=1/0

ONLINEHELP=1/0

REBOOTISREQUIRED=No/Yes

Here is a list of properties you can modify in the Property Table:

Table 15: Properties Editable in Properties Table

DESCRIPTION/DEFAULT SETTING

= Allow internet access
= Default=1

Specifies a license key to activate the product. Add to
the properties table in the .mst file with the license key
as the value.

User can override default path.
User can override default path.

= Deploy libraries per user
= Default=0

=  Extracts libraries at first launch
= Default=1

User can override default path.
User can override default path.

= User Data deployed per user
= Default=1

= Enable Macros in Ul
= Default=1

= Enable online help
= Default=1

= Require reboot after installation
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PROPERTY

TOPICALERTSLINKER=1/0
UICUSTOMIZATION=1/0 (default=1)
SHORTCUTDESKTOP=1/0 (default=1)
SHORTCUTQUICKLAUNCH=1/0

SHORTCUTSTARTMENU=1/0
(default=1)

Recommendations include

MindManager Large-Scale Deployment Guide

DESCRIPTION/DEFAULT SETTING
Default=No

Enable topic alerts linker
Default=1

Enable Ul customization
Default=1

Create Desktop shortcut
Default=1

Create QuickLaunch shortcut
Default=1

Create StartMenu shortcut
Default=1

= Saving these settings to the transform file as a backup, rather than directly to the MSI

= Deploying on a per-machine basis only, avoiding the possibility that the machines with multiple
users get multiple copies of the application installed

= Creating a policy for “Always install elevated,” otherwise the installation may fail
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DEPLOYING WITH WINDOWS
SERVER

You can install with Windows Server 2003 running Terminal Services, and then deploy it to variety of
client machines.

To install on a Windows Server 2003 running Windows Terminal Services (WTS):
1. Log on to the Windows Terminal Server as an administrator.
2. Launch PATH_TO.msi.
3. We recommend using the Add/Remove Programs applet in the Windows Control Panel.
4

Avoid running the installer directly from Windows Explorer unless you are familiar with using the
“change user /install” and “change user /execute” commands.

5. Select Add New Programs and then select CD.
The automatic procedure does not find the setup program.

6. For the Run Installation Program dialog, click Browse.
In the Browse dialog:

7. Change Files of type to Programs.

8. Navigate to the installer location.

9. Select PATH_TO.msi.

10. Click Open and then Next to start the installer.

11. In the Customer Information dialog, leave the User Name blank or chose a “generic” name.
The user can customize this by entering an Organization name and the License Key.

12. In the Setup Type dialog, choose Complete or Custom as desired.
For details about customization, see Deploying with the Installation Wizard (page 19).

13. Complete the installation as outlined in Completing the Installation (page 23).

14. Please make sure to finish the Admin Install wizard of the Windows Terminal Server by clicking

the Finish or Cancel button.

Note: DO NOT START THE APPLICATION BEFORE THIS DIALOG IS FINISHED!

You can now run on the server with the Windows Remote Desktop Connection client.
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The application runs in full color mode and does not support 256-color mode. For best results, run the
terminal server clients in full color mode as well. Deploying under Windows 2000 server will function, but
with less than optimal results.

© 2015 Mindjet All Rights Reserved Version 1.0, April 15, 2015 39



‘ MindManager Large-Scale Deployment Guide

mindjet

DEPLOYING WITH CITRIX XENAPP

A sophisticated terminal server environment built on top of the Windows Terminal Services provided by
Windows Server, the Citrix XenApp is currently the only tested and supported Citrix platform, though
other combinations may also behave properly.

Basic Installation for the Citrix Desktop

For better Citrix performance, do not install the application on a C: drive. After installation, MindManager
appears as part of the Citrix Desktop—a single window containing icons for all the published applications.

Advanced Installation of a “Seamless” Window
You can also install to Citrix as a seamless individual application window, instead of installing as part of
the Citrix desktop, as described above.
To install as a seamless individual application window:
1. Install on a Windows Server 2003 or Windows Server running Windows Terminal Services (WTS)
2. Log on to the server (2003 or 2008).

3. Start the Citrix Delivery Services Console.

@ Internet Explorer 3 [ )
= >
L
Sl Command Prompt
. I Notepad administratar
Documents
¥endpp Server Role Manager
Compuker
Erix sole
Mebwork
% Online plug-in —
Control Panel
@ S0L Server Configuration Manager
Devices and Printers
@ Internet Explorer (64-bit)
. Administrative Tools 3
i’" Internet Information Services {115}
'-\-g 6.0 Manager Help and Support
‘_ Mindjet MindManager 15 Run...
» &l Pragrams ‘Windows Security
I |Search programs and Files ¥e)  Logoff >|
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4. Inthe tree, select Applications.

B Citrix Delivery Services Console _[Ofx=
File Action View Help
e | HElE0ls @
E Citrix Delivery Services Console = -
- - - "
[ s I/ Applications CITRIX
|7 search
LY My Views
= [ Citrix Resources Contents Ilnfurmat\unl Alerts I
E % Configuration Tools Application items in Applications Choase columns
= xn :Otﬂx Management Marne I Type | Status | User Connection Type I
=] ‘f"‘TG?:n'a 1 Calculadorassss Installed Appl...  Enabled Explicit
s A]d;imstrators [ D Installed Appl... Enabled Exxplicit
= jNutePAD Installed Appl... Enabled Explicit
f History
[ Lnad Balancing Policies
Load Evaluators el
Policies &
[=1 =y Servers
[] TBOXENAPR-D1
[% “Warker Groups
[ Zones
0 Single Sign-On
3 items

5. Right-click Applications.
6. Select Publish Applications. (The Application Publishing Wizard appears).

Thiz is the application publishing wizard for Xenfpp. It will guide vou through the process of

Steps publishing an application.
* Welcome
Basic Select Mewt to continue or Cancel ta stop the application publishing process.
Mame
After publishing an application, you can change its settings by selecting the published application
Type and chaosing Modify application propesties from the Commoan Tasks pane in the Delivery Services
L Console.
ocation

Servers
Users
Shortcut
presentation

Publish immediatsly

™ Skip this screen in the future

Cancel
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7. Click Next, in Basic, establish a name for the application.

ciTRIX'

Hame
Steps Enter the name and description that wou want to be displayed ta clients for this application.
v Wielcome Display ame:
Basic [MindManager
LS Name
Tupe Appligation description
Location [The coolest program in the world]
Servers
Users
Shartcut
presentation

Publish immediately

< Back I Next> I Cancel

8. Specify the type of application to publish...

MindManager - Publish Application

CiTRIX'

Tye

“iew the application type.

To change the type. use the Change application type task.

Steps
v Welcome
Basic

v Mame

> Type
Lacation
Servers
Users

Shortcut
presentation

Publish immediately

Chaose the type of application to publish

" Sewver deskiop

€ Content

& Application
Application lype

& Accessed fram a server

Sever application type:

" Streamed if possible, othennise accessed from & server

| Installed appiication

" Streamed to client

=

Typs task
Buick Help

() Mote: To change the application type after publishing it. you must use the Change Applization

Grants users access to a single application already installed on your servers.

< Back I Mext > I Cancel
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9. ...and the application’s location.

MindManager - Publish Application

CiTRIX

Localion
Select and configure the resource being published

Enter the application location

Steps
———— | Enter the command line for the application you want to publish. You can also specity a
v Welcome default working directory for users. More.
Basic

LCommand line:
v MName “C:%Program Files\Mindjet\MindM anager 15\Mindh anager exe

*  Location

Working directory:
C:4Program Files\Mindigtitindt anager 15
Users

Browse... I
Shorteut

presentation

Servers

Publizh immediately

< Back Mest > Cancel

10. Specify which servers will host the application ...

CITRIX
Servers
Configure which servers will hast the application,
Steps Choose the servers on which this published application will run when being delivered via ICA,
Servers;
¥ Welooms Hame Rilative location
Basic THBOXEMAPP-01 Servers
v Mame
v Tupe
v Location
> Servers
Users
Shartcut
presentation
Publizh immediately
1 item
Add, Fiemove | Import from fi
« Back | Mest > | Cancel I
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11. ...and which users will have access to the application. (We recommend doing this by group, to
ease the load of adding single users.)

MindManager - Publish Application (6/8)

Users
Configure the users who may access the applicaion.
" IX
st Specify the users who can access this application. .
eps
| To addusers, choose  drscton type s the batom and sslect Add. blare —
v welcome
Basic Select Users or Groups [ ] =)
v Hame Add List of Names...
v Tie ok
v Losslion & [ETenEnaron ==
v Servers jane |
» Users & Jocken van der Mushl
B ishn 4
Shortcut G keih 4
kati -
presentaion & Lay Daniele |
Publish immeiately & MichaelZaycimnan
& Network Configuration Dperators
B bt Bl
Bemove. ¥ Show users
Configured Accounts
& T<BOXENAPPO1Yjane

0K Canecel

MindManager - Pul

ciTRIX

Users
Configure the users wha may access the application.

Specify the users who can access this application.

Steps

Sees To add users, choose a diectary type at the battom and select Add. Mare...

v welcome

Basic

v Hame

- Type " fllow anorpmous users

v Losstion & Bllow only conligured users

v Servers Lonfigured users:

»  Users B jane TXBOXKENAPP-0TYane)
Sharteut
presentation

Publish immediately

Select directory type IDtw User Selectar =

Add... Hemove |

< Back DNext > Cancel
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12. Configure the Application’s appearance and shortcut location options.

CITRIX'

Shortcut presentation
Canfigure the appearance and location of the application shartcut.
Steps
¥ Welcome These settings function differently an different clients. More...
Basic [ &pplication icon
v Marmne lcon: l Chanag icon...
v Type
v Location LClient application falder:
¥ Servers I
v Users
. Shortcut [ Application shortcut placement
presentation [ Add to the client's §tart menu
Publish immediataly Start menu falder [Citrix *endpp plugin only]:
¥ &dd shorteut to the client's desktap

< Back I Mest> I Cancel

13. One you have established the Basic Settings, you can choose between publishing immediately or
inputting any desired Advanced Settings, including:

MindManager - Publish Application (i

ciTRIX'

Publish immediately

The essential settings far this application have been configured

Steps

o+ Welsame When the wizard s finished, the appication wil be avalable to the corfigured users imediately. |f
you don't want the application to be available immediately, you can disable it until vou are ready.

¥ Basic

¥ Hame . R
I™ Disable application initially

v Tupe

¥ Location

v Semers Advanced application settings default to the mast comman settings and sre not required to be st for
the application to be available to users. You can configure these settings how, or pou can configure

¥ Users them |ater uzsing the application Properties tasks,

v Shortcut

presentation

¥ Configure advanced application settings now
* Publishimmediatel -

Advanced
Access control
Cortent redirection
Limnits
Client options

Appestance

< Back I Mest > I Cancel
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Content Redirection

Content redrection
st Configure the file tppes to be associated with the application,
eps
v Welcome el
b Extension__| Fil Type |
v Basic
v MName
Type
v Location
v Severs
v Usen
v Shartcut
presentation

v Publish immediately

v Advanced

v Access contiol

*  Content redirection

Limits

Client options

Appearance Select &l I Deselect all

¥ Shaw all avallable file types for this application

< Back I Mext x> I Cancel

Limits

MindManager - Publish Application (1

citrRix'

Limits

Configure the application limits
Steps

Concurrent instances

¥ Welcome )

¥ Limit instances allowed to run in server fam
v Basic

Magimum instances: =
v Heme & (EN |
v Tue I Allgw anly ane instance of application far each user
v Location
v Semvers
v Uses
v Shortcut
prssentation

v Publish immediately
v Advanced
v Access control
v Content redirection
> Limits

Client optiors

Appeaiance

< Back I Mext > I Cancel
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Client options

ublish Application (12,13)

CITRIX'

Client options
Steps

v Welcome

¥ Basic

v Name

v Tupe

v Location

v Semers

v Uses

v Shotout

presentation

¥ Publish immediately

v Advanced

v hecess cantal

v Content rediection
v Limits

> Clientoptions

Appearance

Configure the client options for the application

Specify the default seitings for the applicalion when users connect. More:

- Client audio
IV Enable legacy audio
™ Minimum requirement

Note: These audio seffings do not applp to SpeedScreen Multimedia Acceleration

~Connection encryplion
I Enable S5L and TLS protocols

() Important There is no minimum rogquivemert for this option. The sstings on the olent
device £an override this option.

Encuyption

™| Hinimur requiiement

[Basic 3|

Piinting

¥ Start this application without waiting for printers to be created

<Back [ mew> | cancel

Appearance

anager - Publish Application (13/13)

ciTRIX'

Appearance
Steps

v Welcome

v Basic

v Hame

v Tipe

v Location

v Sewes

v Users

v Shortcut )

presentation

v Fublish immediaiely
v Advanced

v bossss contrl
v Content redirection
v Limnits

v Client options

»  Appearance

Configure the application appearance
Session window size:

10244768

Masimum color qually:

Better Appearance (3261

Application Startup Settings

™ Hide application fitle bar

¥ Maximize application at startup

Note: Statup settings are ignored in seamless mode IC4 sessions:

cgsck | Frmsh | Cancel

Once you have completed the installation, you should see the MindManager in the Applications section:
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[H=] E3

e=| 78

[ Citri Delivery Services Cansols
7 alerts
|5 search
5 My Views
2 (3] Citrix Resources
El % Configuration Taols
3 Hotfix Management
= @ Xendpp
= 28 Granja_t
& Administrators
=1 (%) Applications
o] Caleulator
B VD
B vindManager
| NotePaD
i# History
[ Load Balancing Policies
Load Evaluators
Folicies
) servers
5 worker Groups
5 Zones
) single sign-on

f/ Applications

CiTRIX

Contents | Information | alerts |

Application items in Applications

Choose columns

Name [ Type [ status [ User Connection Type |
Calculator Instaled Application Enabled Explick

CHD Instaled Application  Enabled Explicit

notePaD Installed Application  Enabled

1 item selected

- MindManager

Information | servers | Configured Users | Connected Users | Current Settings

Name: MindManager
Type: Installed Application
Status: Enabled

User Connection Type: Explicit

Required Encryption:  Basic

Application Name: MindManager
Last discovery time:  3/27/2015 £:22 PM

The application icon now appears in XenApp Client applications

CiTRIX

Applications

Logged on as: ad

Calculator

A o)

Mindhanager NotePAD

Hint: You can view your resources in several different ways, Use the Select view Contral to change the way that your resources are displayed, [

For more configuration options, please consult your Citrix documentation.

Selectviews [Icons  ~.

Problem Con
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ADMINISTERING MINDMANAGER

There are other administrative issues involved in deploying on a large scale. You can address many of

them using the administrative tools and methods described below.

Managing Add-Ins

The application uses a number of add-in DLLs. The Add-Ins are automatically registered when the

application is installed. On startup, the Add-Ins check for any other required resources (e.g. the supported
version(s) of Microsoft Word). They enable or disable themselves as appropriate. If an add-in fails to start,

it is automatically removed from the list of add-ins (but not from the disk).

Registering or Unregistering Add-Ins from the Command Line
To unregister the Word add-in:
1. Select Start>Run.

2. Enter the command:
regsvr32 /u "C:\Program Files\Mindjet\MindManager 15\Mml0Word.dll"
To restore an unregistered add-in, for example the Word Add-in,

4. Select Start>Run.

Enter the command:
regsvr32 "C:\Program Files\Mindjet\MindManager 15\Mml0Word.dl1l"

Managing Add-Ins from the Registry

Users can enable and disable Add-ins via the Tools > Add-Ins command. However, if desired it is
possible to disable or remove individual add-ins via the Windows Registry.

The Registry Add-In List

The list of add-ins that load at startup can be found in the Registry at:
HKEY LOCAL MACHINE \SOFTWARE\Mindjet\MindManager\15\AddIns

Removing or Restoring Add-Ins from the Registry

To remove an add-in (i.e. make it “invisible” to the application), delete its registry subkey.

© 2015 Mindjet All Rights Reserved Version 1.0, April 15, 2015
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To remove the Word add-in, delete the following key:

HKEY LOCAL MACHINE\SOFTWARE\Mindjet\MindManager\15\AddIns\Mindjet.Mml5W
ord.AddIn.x

This makes the add-in “invisible” to the application so it will not be loaded on program startup and will not
be seen in the list of add-ins in the Tools -> Add-Ins dialog. However, the add-in DLL files still exist on
the hard drive.

Another way to remove an add-in is to unregister it as described in Registering or Unregistering Add-Ins
from the Command Line (page 49). We do not recommend deleting the add-ins DLLs since they will be
restored automatically the next time the program is run via its shortcut.

Enabling or Disabling Add-Ins from the Registry
Users can disable or enable a given add-in directly via the Tools -> Add-Ins command. Add-ins can also
be disabled via the Windows Registry as described below.
There are two keys to consider when disabling an add-in for a given user:
HKEY LOCAL MACHINE\SOFTWARE\Mindjet\MindManager\15\AddIns\AddInName
HKEY CURRENT USER\SOFTWARE\Mindjet\MindManager\15\AddIns\AddInName
Where AddInName is the actual name of the add-in (e.g. Mindjet.Mm15Word.AddIn.x).

When a given user starts the application, the program checks first in the HKEY CURRENT USER subkey
for a “LoadBehavior” value. If it exists, it is used.

If the “LoadBehavior” value does not exist, the application copies the LoadBehavior value from the
HKEY LOCAL MACHINE subkey tothe HKEY CURRENT USER subkey and then uses that value.

Therefore, to disable an add-in for the current user, set the LoadBehavior value in the
HKEY CURRENT_USER subkey to 0.

To disable the add-in for all new users, set the LoadBehavior value in the HKEY LOCAL MACHINE
subkey to 0.

Note: This has no effect on users that have already run the application at least once. For them you must
set LoadBehavior in the HKEY CURRENT_ USER subkey.

Similarly, setting LoadBehavior to 2 enables the add-in again.

Managing Microsoft Office Add-Ins

When the application is installed, it registers add-ins for MS Office products. The location of this add-in
registration in the Windows Registry depends on the application and the add-in.

For example, the add-in for Microsoft Word is registered on a per-machine basis (so all users of the
machine have it) at:

HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Office\Word\Addins\Mindjet.Mml5Wo
rd.AddIn.x

Note that Word handles the Tools -> "COM Add-Ins" command and user interface differently than
MindManager.
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= InWord, if an add-in is registered in HKEY_LOCAL_MACHINE (HKLM), then it is not displayed in

the COM Add-Ins dialog.
» If an add-in is registered in HKEY_CURRENT_USER (HKCU), it is displayed in the dialog and

can be turned off and on.
= If the add-in is registered both in HKLM and HKCU, Word ignores the HKCU entry and just uses

the HKLM entry.

The registry data values for the Microsoft program add-ins are the same as described for the add-ins, and
can be edited in a similar fashion.

Managing from the Registry

To allow system administrators to control the environment presented to their users, the application
supports registry settings, which can be set via the user interface. However, registry settings relevant to
Large-Scale Deployment are not available from this user interface. See also the user data installation
options on page 6, which are similarly adjusted via registry settings.

HKEY_LOCAL_MACHINE Settings

The following registry settings are used on a per-machine basis:
HKEY LOCAL MACHINE\SOFTWARE\Mindjet\MindManager\1l5\Registration

Table 16: HKEY_LOCAL_MACHINE Registration Values

VALUE NAME TYPE VALUE DATA

ShowLicense REG_DWORD 0 to not show the license key being used or allow
it to be changed.

1 to show the license key
ChangelLicense REG_DWORD 0 to prevent changing the license key.
1 to allow the license key to be changed.

The following registry settings are used on a per-machine basis:
HKEY LOCAL MACHINE\SOFTWARE\Mindjet\MindManager\1l5\Settings

Table 17: HKEY_LOCAL_MACHINE Settings

VALUE NAME TYPE VALUE DATA

LocalUserDataDirectory = REG_SZ Path to copy user data files (e.g. Image Library
files, etc.) at first launch. May contain
environment variables.

For example:

N:\UserData\%USERNAMES% \MindManager
15

© 2015 Mindjet All Rights Reserved Version 1.0, April 15, 2015 51



A

mindjet

VALUE NAME TYPE

PerUserlnstallation REG_DWORD

HKEY CURRENT_USER Settings

MindManager Large-Scale Deployment Guide

VALUE DATA
If no path is specified, then this path is assumed:
$USERPROFILE%\Local Settings\
Application Data\MindManager\15

This setting can be overridden by the same
setting in HKEY_CURRENT_USER (see below)
or by the LSDUserDataPath setting described
earlier.

0 for per-machine license key management.

1 for per-user license key management.

The following registry settings are used on a per-user basis:
HKEY CURRENT USER\SOFTWARE\Mindjet\MindManager\15\Settings

Table 18: HKEY_CURRENT_USER Settings

VALUE NAME TYPE
AllowUpdateCheck REG_DWORD
DisableAnimation REG_DWORD
LocalUserDataDirectory = REG_SZ

VALUE DATA
0 to hide the Help, Check for Updates command.
1 to show this command.

2 to show this command only if the user has write
privileges to HKEY_LOCAL_MACHINE (default)

0 to allow animation of maps for smoother
scrolling.

1 to disable animation of maps for one-jump
scrolling, which is less graphics intensive and
perhaps more desirable in a low-bandwidth
Windows Terminal Server environment.

Path to copy user data files (e.g. Image Library
files, etc.) to when a new user first launches. May
contain environment variables.

For example:

N:\UserData\%USERNAMES% \MindManager
15

If no path is specified, then this path is assumed:

$USERPROFILE%\Local
Settings\Application
Data\MindManager\15

This setting can be overridden by the
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VALUE NAME TYPE VALUE DATA

LSDUserDataPath setting described earlier.

Managing with Event Macros

The application can trigger certain Event Macros that can help system administrators monitor the usage
of the program more carefully.

» These macros are examples only. You need to customize them for your environment.

= Microsoft added the Outlook Object Model Guard starting with Outlook version 2002, forcing the
display of an alert message informing the user that a program is trying to access or send a
message via Outlook, which the user must approve before proceeding. This behavior can be
controlled by Outlook system policies.

Table 19: Event Macros

EVENT NAME WHEN FIRED
OnApplicationStarted At the end of Initinstance (only when started in “normal” mode, not
/RegServer, /UnregServer, etc.)
OnExpiredTrialStarted Just before the “Trial Expired” dialog
OnFirstUse Just before installation of “per-user data”
OnBuyButtonPressed Just before the “Buy MindManager” dialog is displayed

When a macro event is fired, 0 or more macros are run. The mapping of macro event names to macro
filenames is determined on startup.

On startup, the application looks in the registry
atHKEY LOCAL MACHINE\SOFTWARE\Mindjet\MindManager\15for a key named Event Macros. If it
is found, expect to find keys such as these:

Event Macros\
OnApplicationStarted\
EventMacro OnApplicationStarted.mmbas
EventMacro_ OnApplicationStartedTwo.mmbas

Path="C:\Temp\EventMacro OnApplicationStartedTwo.mmbas"
OnBuyButtonPressed\
EventMacro_ OnBuyButtonPressed.mmbas
OnExpiredTrialStarted\
EventMacro_ OnExpiredTrialStarted.mmbas
OnFirstUse\
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EventMacro OnFirstUse.mmbas

Each event key can have 0 or more macro key names. Each macro key can have an optional “Path”
value.

» If the “Path” value is not there, then the key name is the path.
» If the path is a relative path (e.g. "EventMacro_OnApplicationStarted.mmbas"),itis

converted to an absolute path relative to the default macro folder for the user (e.g.
"C:\Documents and Settings\username\lLocal Settings\Application

Data\Mindjet\MindManager\15\macros").

If the “Event Macros” key is not in the registry, then the application looks for event macros in the default
macro folder (see above) with a name of the form:

EventMacro_<EventName>.mmbas

For example:
EventMacro OnApplicationStarted.mmbas

Therefore, it is possible to get macro events to run a macro simply by putting macros with the proper
name in the user's macro folder. However, for most typical IT uses, the “Event Macros” key will be used,
since this can point to macros on a network drive, for example.

For example, this "EventMacro_OnApplicationStarted.mmbas" macro uses the Outlook object
model to send a notification email:

'#Uses "EventMacro Utilities.mmbas"
Sub Main
SendNotificationEmail "MindManager event: Application Started"
End Sub
Where the “EventMacro_Ultilities.mmbas” file contains:
' Utilities for use with MindManager event macros
Public Sub SendNotificationEmail (eventString As String)
' Sends the subject string to the appropriate IT person

' to notify them of the MindManager event that just occurred

' Get access to our email program
Dim outlookApp As Outlook.Application
Set outlookApp = New Outlook.Application

' Create a message
Dim message As Outlook.MailItem
Set message = outlookApp.CreateItem(olMailItem)

message.To = "System Administrator"
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message.Subject = eventString
message.Body = eventString
' Send the message
message.Send
End Sub

Managing User Licenses

Each user must have a license. Please contact your reseller or Mindjet sales representative for licensing
terms appropriate for Large-Scale Deployment. MindManager does not include any special support for
proprietary third-party license management software.

MindManager can check and administer license keys on a per-user or per-machine basis. The application
first looks for a license key in:

HKEY LOCAL MACHINE\SOFTWARE\Mindjet\MindManager\1l5\Registration\

The default installation administers license keys on a per-machine basis. A license key can be entered
after the program is installed, and all users of that machine have access to the program via that key.

To achieve per-user license key administration:

1. |Install with no license key: use the installation wizard (which does not ask for a key), or use
command-line installation without specifying a license key.

Or, set the registry key:
HKEY LOCAL MACHINE\SOFTWARE\Mindjet\MindManager\15\Settings\PerUserInst

allation to 1 after installation. This setting instructs the application to save any license key the
user enters to the HKCU setting instead of the HKLM setting.

2. The administrator should put the user's license key in the user's HKCU registry setting (above)—
or provide the user with the license key so s/he can enter it in the license key dialog that is
automatically displayed upon launching in Trial mode.

Policies Support

The application does not offer official Windows Policies support.

MindManager Linker for SharePoint
Note: To use MindManager with Microsoft SharePoint, you must purchase and install MindManager
Enterprise, which includes MindManager Linker for SharePoint.

MindManager Linker for SharePoint supports an optional silent argument for deploying a SharePoint
SITECONNECTIONFILE as a way to pre-populate custom SharePoint connections.

Optional silent install argument:
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SITECONNECTIONFILE=full path to_custom site connection file

This file can have any name but must be reachable from install-to machine. The file is copied to
“SiteConnections.xml” in the SharePoint Linker INSTALLDIR.

Note: This argument will have no operational effect when the application runs if the SharePoint Add-In is
not active.

Proxy Server Support

The application supports proxy server connections to the internet, including overriding default Microsoft
Internet Explorer settings.

Mindjet Options -m
General Proxy Settings
View :
Edit Proxy type:
Visual Effects () MNo proxy
Spenl&fsavet' @) Use default Windows settings
ser Information
Motes () HTTPIHTTPS:
Spelling Host
Topic Alerts
Review
Security
Add-Ins s
Transformations [V] User name and password are required
Package Folders Beardi:

Online Access

(Proxy Settings |
Task Info

Databases Password:
SharePaint

[V]|Remember username and password between application sessions

If a domain is needed, include it with vour user name like this:
"domainiusername",

OK ] [ Cancel

Primary path:
1. Select Proxy Settings from MindManager->File->Options.

2. Choose Auto-detect/Use system proxy settings (e.g. set by system or w/in IE) or Manual proxy
configuration (no proxy, https).

3. Set proxy settings for manual proxy configuration.

Alternate path:
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1. System administrator sets proxy settings (Host & Port) for Large-Scale Deployment.

2. When installed, MindManager options are configured based upon on System Administrator user's
configuration.

3. System Administrator has an option to hide the ability to remember Username and Password for the
HTTPS proxy settings.

Impacted areas:

* Online (Files) - New/From Maps for that Gallery, Sign in/out, and Tasks.
* Notifications; Creating/deleting files; folders, Co-editing and Sharing.

* Trial display messages emanating from Mindjet servers.

* Tasks

* Connection — sign in/sign out

* Check for updates

* All the web services Map Parts

* SharePoint Add-in

* Database linker

* To use MindManager with Microsoft SharePoint, you must purchase and install MindManager
Enterprise.

The registry settings are as follows:

HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\15\Settings\ProxyType = 0 (no proxy) -
DWORD type

1 = Use default windows settings

2 = Use custom proxy settings

In case your proxy type is set to custom, you can set a custom proxy as follows:

HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\15\Settings\ProxyHost = host name -
STRING

HKEY_LOCAL_MACHINE\SOFTWAREMindjet\MindManager\15\Settings\ProxyPort = port name -
DWORD

HKEY_LOCAL_MACHINE\SOFTWAREWMindjet\MindManager\15\Settings\ProxyAuthenticationRequired -
DWORD (can be 0 or 1)

HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\15\Settings\ProxySaveCredentials -
DWORD (can be 0 or 1) - is used to save proxy credentials across application sessions
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